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Computerized Payroll Accounting 
 
 

PAYROLL PROJECT 
 

 In this project, you are employed by Glo-Brite Paint Company as the person in the 
accounting department responsible for the company's payroll processing using the 
computerized payroll system described in the preceding material. 
 
 You will assume that the payroll records, tax reports, and deposits have been 
completed and filed for the first three quarters of this year. Your work will involve the 
computer processing of the payrolls for the last quarter of the year. 
 
 To help you get started, the first pay period is provided as a tutorial problem that 
illustrates the principles and procedures required to process p a y r o l l  transactions using 
the Payroll Accounting software. In subsequent pay period processing, whenever a new 
operational procedure is used for the first time, additional instruction will be provided. 
Each of the following step-by-step instructions lists a task to be completed at the 
computer. If you need additional explanation for the task, a page reference is provided 
from the "Computerized Payroll Accounting User's Guide" see below. 

 
 
 

OCTOBER 9 PAYROLL 
 
 

1. Start up the Payroll Accounting software (page UG-2). 
2. Load the opening balances template file, Payroll File 2014.IA7   (page UG-3).  Pull 

down the File menu and choose the Open menu command. Select Payroll File 2014.IA7 
from the File list box and click on OK.  

3. Enter your name in the User Name text box and click on OK. 
4. Enter the employee maintenance data (page UG-12).  Click on the Accts. toolbar 

button. Select employee number 180 (Student), key your name in the Name field 
(enter your last name in all capital letters si milar to the other employees), then 
click on the Change Employee command button. 
* *Note: Do not change any of the other fields. If you do, your solutions will not be 

correct. 
5. Enter the Payroll transactions.   

• Do  not deduct  Group Ins 

• Do deduct Union Dues for the appropriate employees 

• Do not deduct Simple Plan (which is the same as Simple Contributions Payable) (page 
UG-12). 
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• Click on the Payroll toolbar button. Click on the Deductions button.  When the 
Voluntary Deductions dialog box appears, select only the Union Dues deduction, 
and then click on OK. Enter the payroll transaction data provided below on the 
blank line at the bottom of the cell grid (the existing data are beginning 
balances and should not be altered). Have the computer Calculate Taxes. The 
Voluntary Deductions dialog box will appear again while entering the first 
employee's data to let you verify that only the Union Dues deduction has been 
selected (this will occur whenever the date entered in the Date field is changed ) 
When done with the employee data, click OK.  This will create another blank line 
below the last employee.  Repeat the process for each employee. 

**Note: It is very important that you enter the correct date (10/09/14) when 
entering the payroll transactions. Payroll processing is date sensitive 
and will accumulate and display incorrectly if the dates are entered 
incorrectly. Also, be sure to enter the correct Union Dues ($8.00) for 
the two appropriate employees. (The $72.00 amounts that are shown are 
carried over from the opening balances.) 

 

Employees to Be Paid This Pay Period 

  

 
6. Display the employee list report (page UG-20).  Click on the Reports toolbar 

button. Choose the Payroll Reports option. Select the Employee List report, and 
then click on OK. The report is shown in Figure A- 1 (on following page).  Verify the 
accuracy of the maintenance input and make any corrections via the Employees tab 
in the Account Maintenance window. 

 
  



 

3 Computerized Payroll     2/25/19 

 

 
 
 
 
 

7. Display the payroll report (page UG-21).  Make sure the Run Date is set to 
10/09/14; then choose the Payroll Report option and click on OK. The payroll 
report for Employee 100; Bonno, Anthony Victor, followed by the payroll summary 
is shown in Figure A-2 on the following page. 
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8. Generate and post the journal entry for the current payroll (page UG-13). 
Choose the Current   Payroll   Journal   Entry   menu   item   from   the Options 
menu.  Click Yes when asked if you want to generate the journal entry. When the 
entry appears in the Current Payroll Journal Entries dialog box, as shown in 
Figure A-3 (on the following page), click on Post. The journal entry will reappear, 
posted, in the general journal. 

 If your journal entries do not match those shown in Figure A-3, check your 
employee list and payroll report for keying errors, and make the necessary 
corrections. Return to the General Journal window, delete the incorrect entries, 
and generate new entries. 
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9. Generate and post the employer's payroll taxes journal entry (page UG-13).  

With the General Journal window still displayed, choose Employer's Payroll Taxes 
from the Options menu. Click Yes when asked if you want to generate the journal 
entry. When the entries appear in the Payroll Taxes Journal Entries dialog box 
shown in Figure A-4, click on Post. The journal entries will reappear, posted, in the 
general j ournal. 
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10. Enter and post the October 9 general journal entry to record the deposit 

of cash for the total net amount owed to employees in the payroll cash 
account (page UG-19). Click on the Journal toolbar button. When the General 
Journal tab appears, enter the journal entry illustrated in Figure A-5. Be sure to 
enter a reference of General to indicate that the entry was entered manually in the 
general journal. 

 
 
 

11. Display the general journal report (page UG-21).  Click on the Reports toolbar 
button. Choose the Journals option and the General Journal report, and then click 
on OK. When the Journal Report selection window appears, choose the Customize 
Journal Report option. Make sure the Start Date is set to 10/01/14 and the End Date 
to 10/09/14 (where -- is the current year), and then click on OK.  

**Note: If the transactions were entered correctly, the Start and End Dates will 
be the default dates set automatically by the computer. The computer uses 
the first clay of the month as the Start Date and the latest date of the 
general journal transactions that were entered as the End Date. The 
General Journal report is shown in Figure A-6. 
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12. Display the general ledger report (page UG-21).  Choose the Ledger Reports 
option and the General Ledger Report, and then click on OK. When the Account 
Range dialog box appears, click on OK to accept the default range of all 
accounts. The General Ledger report is shown in Figure A-7 on the following page.   

13. Use the Save As command to save your data to disk (page UG-10)Choose 
Save As from the File menu and save the file to your disk and folder with a file 
name of 10-09 your name (where 10-09 is the pay period date) 

14. End the payroll accounting session (page UG-11).  Choose Exit from the 
File menu. 
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OCTOBER 23 PAYROLL 
 
The step-by-step instructions for completing the October 23 payroll (for the period ending 
October 17) are listed below. 
1. If you  quit the software after processing the previous pay  period, perform the 

following steps: 

• Start up the Payroll Accounting software. 
• Load your file containing the last pay period data (10-09 your name). 

2. Enter and post the October 20 transaction required to record the deposit of the 
Pennsylvania state income taxes withheld from the October 9 payroll. 

3. Enter the following payroll transactions.  

• Do deduct Group Ins 
• Do deduct Union Dues for the appropriate employees 
• Do Not deduct Simple Plan (which is the same as Simple Contributions Payable). 

**Note: Be sure to enter the correct Group Insurance amount for each employee 
(the default amounts that appear are carried over from the opening balances). Also, 
since the union dues entered in the previous payroll are assumed by the computer 
to be the same for future pay periods, it will not be necessary to enter these 
amounts again. However, it is a good idea to verify that they are the same as those 
in the payroll transactions below. 

 
 

4. Display the payroll report. 
5. Generate and post the journal entry for the current payroll. 
6. Generate and post the journal entry for the employer's payroll taxes.  
7. Enter  and  post the  October 23 general  journal entry  to  record  the deposit of cash  

for the total  net amount owed  to employees in  the payroll cash account. 
8. Display the journal report for l 0/ I 0/-- through 10/23/--.  
9. Display the general ledger report. 
10. Use the Save As command to save the October 23 payroll to disk with a file name 

of 10-23 your name (where I0-23 represents month 10, day 23). 
  



// 
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11. Proceed to the November 6 payroll.  If necessary, end your payroll accounting session. 
 

NOVEMBER 6 PAYROLL 
 
The  step-by-step  instructions  for  completing  the  November  6 payroll  (for  the period 
ending October 31) are listed below. 
1. If you quit the software after processing the previous pay period, perform the following 

steps: 

• Start up the Payroll Accounting software. 
• load your file containing the last pay period data (10-23 your name). 

2. Enter and post the following transactions: 
3. November 4: Deposited the Pennsylvania state income taxes withheld from the 

October 23 payroll. 
4. November 6: Paid the treasurer of the union the amount of union dues withheld during 

the month of October. 
5. Enter the following employee maintenance: 

• Change Virginia Russell's number of withholding allowances to 2.  
• Change Thomas J. Sokowski's marital status to Single (his number of withholding 

allowances remains at 2).  
• Change Dewey Mann's number of withholding allowances to 0. 

6. Enter the following payroll transactions.  

• Do Not deduct Group lns 
• Do deduct Union Dues for the appropriate employees 
• Do not deduct Simple Plan (which is the same as Simple Contributions 

Payable). Verify that Group Insurance is not deducted and that Union Dues 
are deducted for the appropriate employees. 

**Note:  Enter the amounts shown for Virginia Russell and Ruth Williams to override 
their regular salary amounts. 
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7. Display an employee list report.  
8. Display the payroll report. 
9. Generate and post the journal entry for the current payroll. 

10. Generate and post the journal entry for the employer's payroll taxes.  
11. Enter  and  post  the November  6 general  journal  entry  to  record  the deposit  

of  cash  for  the total  net  amount  owed  to employees  in  the payroll cash 
account. 

12. Display the journal report for l0/24/-- through 11/06/--.  
13. Display the general ledger report 
14. Use the Save As command to save the November 6 payroll to disk with a file 

name of 11- 06 your name (where 11-06 represents month 11, day 06).   

15. Proceed to the November 13 payroll. If necessary, end your payroll 
accounting session. 

 
 
NOVEMBER 13 PAYROLL 
 
A special payroll needs to be run to process a discharged employee (Ruth Williams has 
been discharged because of her excessive tardiness and absenteeism). The step-by-
step instructions for completing the November 13 special payroll are listed below. 

1. If you quit the software after processing the previous pay period, perform the 
following steps: 

• Start up the Payroll Accounting software. 

• Load your file containing the last pay period data (11-06 your name). 
2. Enter Ruth V. Williams' payroll transaction (do deduct Group Ins of $14.40). 
3. Enter $2,079.32 in her salary [two partial weeks of work ($856.24), plus two full 

weeks' pay ($1,223.08) in lieu of two weeks' notice for her final pay]. 
4. Display the payroll report. 
5. Generate and post the journal entry for the current payroll. 
6. Generate and post the journal entry for the employer's payroll taxes.  
7. Enter and post the November 13 general journal entry to record the deposit of 

cash for the total net amount of Ruth Williams' pay in the payroll cash account. 
8. Display the journal report for 11/07/-- through 11/13/--.  
9. Display the general ledger report. 

10. Use the Save As command to save the November 13 payroll to disk with a file 
name of 11-13 your name (where 11-13 represents month 11, day 13). 

11. Proceed to the November 20 payroll.  If necessary, end your payroll session. 
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NOVEMBER 20 PAYROLL 
 
The step-by-step instructions for completing the November 20 payroll (for the period 
ending November 14) follow. 

1. If you  quit  the  software  after  processing  the  previous  pay  period, perform  the 
following steps: 

• Start up the Payroll Accounting software. 

• Load your file containing the last pay period data (1 1-13 your name). 
2. Enter and post the following transactions: 

• November 16: Deposited with City Bank the amount of FICA taxes and 
federal income taxes for the October payrolls. 
**Hint: Display the general ledger report to obtain these amounts from the 

FICA Taxes Payable-OASDI, FICA Taxes Payable-HI, and the 
Employees FIT payable account balances as of October 23. 

• November 16: Deposited the city of Philadelphia employees withheld income 
tax ($1,125.25) with the Department of Revenue for the October payrolls 
(see the Employees CIT Payable account balance in the general ledger 
report). 

• November 18: Deposited the Pennsylvania state income taxes withheld from 
the November 6 and 13 (Ruth V. Williams) payrolls. 

3. Enter the following employee maintenance: 

• Add new employee: Employee number 200; WOODS, Beth Anne; 8102 
Franklin Court, Philadelphia, PA 19105-0915; social security number, 000-
00-1587; single, salaried, $1,200.00; number of pay periods per year, 26; 
withholding allowances, 1; Account No. 52 (Office Salaries). 

4. Enter the following payroll transactions.  

• Do deduct Group Ins 

• Do deduct Union Dues for the appropriate employees 

• Do deduct Simple Plan (which is the same as Simple Contributions Payable) for 
the appropriate employees.  

• Verify that Group Insurance is deducted, that Union Dues are deducted, 
and that Simple Plan (Simple Contributions Payable) is deducted for the 
appropriate employees.  
**Note: This is the first pay in which the company offers a savings incentive 

match plan. The computer software has been designed to use the 
key terms "Simple Plan" to instruct it to exclude this deduction from 
the employee's income for FIT purposes. The general ledger 
account Simple Contributions Payable is associated with this term 
for updating during payroll transaction processing. 
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5. Display an employee list report.  
6. Display a payroll report. 
7. Generate and post the journal entry for the current payroll. 
8. Generate and post the journal entry for the employer's payroll taxes. Enter and 

post the November 20 general journal entry to record the deposit of cash for the 
total net amount owed to employees in the payroll cash account. 

9. Display the journal report for 11/14/-- through 11/20/--.  
10. Display the general ledger report. 
11. Use the Save As command to save the November 20 payroll to disk with a file 

name of 11-20 your n a m e  (where 11-20 represents month 11, day 20). 
12. Proceed to the December 4 payroll. If necessary, end your payroll session. 
 
 
DECEMBER 4 PAYROLL 
The step-by-step instructions for completing the December 4 payroll (for the week ending 
November 28) follow. 
1. If you  quit  the  software after processing the previous pay period, perform the 

following steps: 

• Start up the Payroll Accounting software. 

• Load your file containing the last pay period data ( 11-20 your name). 
2. Enter and post the following transaction: 

• December 3: Deposited the Pennsylvania state income taxes withheld from 
the November 20 payroll. 
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3. Enter the following employee maintenance: 

• Change Catherine L. Ford's salary amount to $960.00 because of a 
salary increase. 

• Change Virginia Russell's salary amount to $750.00 because of a salary 
increase. 

• Add new employee: Employee number 210; YOUNG, Paul Winston; 7936 
Holmes Drive, Philadelphia, PA 19107-6107; social security number, 000-00-
6057; single, salaried, $807.70; number of pay periods per year, 26; 
withholding  allowances, 1; Account  No.  53 (Sales Salaries). 

4. Enter the following payroll transactions.  

• Do Not deduct Group Ins 

• Do deduct  Union  Dues  for  the  appropriate employees 

• Do deduct Simple for the appropriate employees. 
 

 
 
5. Display an employee list report.  

6. Display a payroll report. 
7. Generate and post the journal entry for the current payroll. 
8. Generate and post the journal entry for the employer's payroll taxes.  
9. Enter  and  post  the  December  4 general  journal entry  to  record  the deposit  of  

cash  for the  total  net  amount  owed  to employees in  the payroll cash account. 
10. Display the journal report for 11/21/-- through 12/04/--.  
11. Display the general ledger report. 
12. Use the Save As command to save the December 4 payroll to disk with a file name of 

12-04 your name (where 12-04 represents month 12, day 04).  
 
13. Proceed to the December 14 payroll. If necessary, end your payroll session. 
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DECEMBER 14 PAYROLL 
 
A special payroll needs to be run to process the death of an employee (Virginia A. 
Russell). The step-by-step instructions for completing the December 14 special payroll 
follow. 
1. If  you  quit  the  software  after  processing  the  previous  pay  period, perform 

the following steps: 

• Start up the Payroll Accounting software. 

• Load your file containing the last pay period data (12-04 your name). 
2. Enter and post the following transaction: 

• December 9: Paid the treasurer of the union the amount of union dues 
withheld during the month of November. 

3. Enter the employee maintenance: 

• Change Anthony V. Bonno's number of withholding allowances to 5.  

• Pay Virginia  A. Russell ( pay will go to her estate). (Do deduct $8.70 for her 
Group Ins.)  Enter $1,425.16 in her salary amount, which is two partial weeks of 
work ($675. 16) plus her accrued vacation pay ($750.00) for her final check. 
**Note: After clicking on the Calculate Taxes command button, remove the 

calculated withholding a mounts for FIT, SIT, and CIT by keying zeros 
in these grid cells (final pay is not subject to these withholdings). 
Display an employee list report. 

4. Display a payroll report. 
5. Generate and post the journal entry for the current payroll. 
6. Generate and post the journal entry for the employer's payroll taxes. Enter  and  

post  the December 14 general journal  entry  to record  the deposit  of cash  for 
Virginia  A. Russell 's net amount in  the payroll cash  account. 

7. Display the journal report for 12/05/-- through 12/14/--. 
8. Display the general ledger report. 
9. Use the Save As command to save the December 14 special payroll to disk with a 

file name of 12-14 your name (where 12-14 represents month 12, day 14). 
10. Proceed to the December 18 payroll. If necessary, end your payroll session. 
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DECEMBER 18 PAYROLL 

The step-by-step instructions for completing the December 18 payroll (for the week 
ending December 12) follow. 
1. lf you  quit the software after processing the previous  pay period, per form 

the following steps: 

• Start up the Payroll Accounting software. 

• Load your file containing the last pay period data (12-14 your name). 
2. Enter and post the following transactions: 

• December 15: Deposited with City Bank the amount of FICA taxes and 
federal income taxes for the November payrolls. 

• December 15: Deposited the city of Philadelphia employees income tax 
withheld by the Department of Revenue from the November payrolls. 

• December 18: Deposited the Pennsylvania state income taxes withheld 
from the December 4 payroll. 

• December 18: Wrote check to Virginia Russell's estate from the regular 
cash account for the amount withheld from her December 14 pay for 
insurance. 

3. Enter the following employee maintenance: 

• Change: Employee number 140; O'Neill, Joseph Tyler withholding allowances 
to 4. 

• Add new employee: Employee number 220; ZIMMERMAN, Richard Lewis; 
900 South Clark Street, Philadelphia, PA 19195-6247; social security 
number, 000-00-1502;  married, salaried, $660.00; number of pay periods 
per year, 26; withholding allowances, 1; Account No. 52 (Office Salaries). 

4. Enter the following payroll transactions.  

• Do deduct Group Ins 

• Do deduct Union Dues for the appropriate employees 

• Do deduct Simple for the appropriate employees. 
**Note: Be sure to enter the changes and amounts of Group Ins. deductions for 

the new employees and the $9.00 Union Dues, as noted below. Also, be 
sure to enter the change to Joseph O'Neill's Simple Plan deduction. 

**Note: In this pay, O'Neill has reached the OASDI ceiling. To calculate 
O'Neil's OASDI tax, multiply the OASDI ceiling of $113,700 by 6.2% 
and then subtract the year-to-date OASDI taxes withheld as 
reported on the December 14 payroll report.  After clicking on the 
Calculate Taxes command for O'Neill, override the calculated amount 
by keying the amount calculated by hand . 
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5. Display an employee list report.  
6. Display the payroll report. 
7. Generate and post the journal entry for the current payroll. 
8. Generate and post the journal entry for the employer's payroll taxes. Enter and 

post the December 18 general journal entry to record the deposit of cash for the 
total net amount owed to employees in the payroll cash account. 

9. Display the journal report for 12/15/-- through 1 2/18/--. 
10. Display the general ledger report.  
11. Use the Save As command to save the December 18 payroll to disk with a file 

name of 12-18 your name (where 12-18 represents month 12, day 18). 
12. This completes the project insofar as recording and processing the computerized 

payroll transactions for the last quarter is concerned. End your payroll session. 
13. Submit the 12/18 file through the project drop box in Canvas.  This is the only file 

required to be submitted.  Submissions work best in Mozilla Firefox.  Let me know 
if you have issues submitting the project. 
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